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Introduction

This document is intended for use with IBM® Cognos® Dynamic Cubes. IBM
Cognos Dynamic Cubes is used with IBM Cognos Business Intelligence to provide
business users and analysts with the ability to model dimensional metadata and to
create dynamic cubes to use as data sources in the Content Manager.

This document includes installation instructions for IBM Cognos Cube Designer
and IBM Cognos Dynamic Query Analyzer.

Audience

This guide is intended for system administrators. To use this guide, you should
have basic Microsoft Windows, UNIX, and Linux administration skills.

Finding information

To find BI Pattern with BLU Acceleration product documentation on the web,
access the IBM Business Intelligence Pattern with BLU Acceleration Information
Center (http://pic.dhe.ibm.com/infocenter/cbiima/v1r0m0/index.jsp).

To find IBM PureApplication™ System product information on the web, access the
IBM PureApplication System information Center (http://pic.dhe.ibm.com/
infocenter/psappsys/v1r1m0/index.jsp).

To find IBM DB2® product information on the web, access the IBM DB2
information Center (http://pic.dhe.ibm.com/infocenter/db2luw/v10r5/index.jsp).

Accessibility Features

Accessibility features help users who have a physical disability, such as restricted
mobility or limited vision, to use information technology products. IBM Cognos
Dynamic Cubes has accessibility features. For information on these features, see the
accessibility section in this document.

IBM Cognos HTML documentation has accessibility features. Adobe PDF
documents are supplemental and, as such, include no added accessibility features.

Forward-looking statements

This documentation describes the current functionality of the product. References
to items that are not currently available may be included. No implication of any
future availability should be inferred. Any such references are not a commitment,
promise, or legal obligation to deliver any material, code, or functionality. The
development, release, and timing of features or functionality remain at the sole
discretion of IBM.

Samples disclaimer

The Sample Outdoors Company, Great Outdoors Company, GO Sales, any
variation of the Sample Outdoors or Great Outdoors names, and Planning Sample
depict fictitious business operations with sample data used to develop sample
applications for IBM and IBM customers. These fictitious records include sample

© Copyright IBM Corp. 2013 v

http://pic.dhe.ibm.com/infocenter/cbiima/v1r0m0/index.jsp
http://pic.dhe.ibm.com/infocenter/cbiima/v1r0m0/index.jsp
http://pic.dhe.ibm.com/infocenter/psappsys/v1r1m0/index.jsp
http://pic.dhe.ibm.com/infocenter/db2luw/v10r5/index.jsp
http://pic.dhe.ibm.com/infocenter/db2luw/v10r5/index.jsp


data for sales transactions, product distribution, finance, and human resources.
Any resemblance to actual names, addresses, contact numbers, or transaction
values is coincidental. Other sample files may contain fictional data manually or
machine generated, factual data compiled from academic or public sources, or data
used with permission of the copyright holder, for use as sample data to develop
sample applications. Product names referenced may be the trademarks of their
respective owners. Unauthorized duplication is prohibited.
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Chapter 1. Components and tools used by IBM Cognos
Dynamic Cubes

IBM Cognos Dynamic Cubes adds a relational OLAP component to the Dynamic
Query Mode server to provide a multidimensional view of a relational data
warehouse. You can then perform OLAP analysis by using the Cognos Dynamic
Cubes server.

IBM Cognos Dynamic Cubes integrates easily into your existing infrastructure by
using resources that are already in your environment. Some of these existing
resources are required, such as a Java™ virtual machine, or other databases for the
content store. The Administration Console is used to deploy and manage the cube
data. The dynamic query mode (DQM) server runs the cube data, and studio
applications use the data in reporting environments.

IBM Cognos Cube Designer provides dynamic cube design and modeling
capability. IBM Cognos Dynamic Query Analyzer is used to analyze and optimize
the data as necessary.

Cognos Dynamic Cubes Workflow

The workflow for IBM Cognos Dynamic Cubes consists of five major steps. Users,
such as the system analyst administrator, modeler administrator, or report author
use various tools to manage and administer these steps.

The following steps are included in the workflow:
v Analyzing the data

Before installing IBM Cognos Dynamic Cubes, the modeler and relational
database administrator determine whether the data is a good candidate for IBM
Cognos Dynamic Cubes.

v “Designing and preparing dynamic cubes - IBM Cognos Cube Designer” on
page 3
The modeler creates a basic dynamic cube, adds features to satisfy the business
requirements, and ensures that the cube is available to IBM Cognos
Administration.

v Deploying and managing a dynamic cube
After dynamic cubes are published to Content Manager, the Administrator
handles the initial configuration and subsequent management within IBM
Cognos Administration.

v “Application tier components” on page 2
The report author uses the dynamic cube as a data source in reporting
applications.

v “IBM Dynamic Query Analyzer” on page 2
To optimize individual cube performance, the administrator can monitor the
metrics of the dynamic cubes, and change, if necessary, the cube configuration.

© Copyright IBM Corp. 2013 1



Server components
Server components provide the user interfaces for reporting and product
configuration, including the server functionality for routing and processing user
requests. Server components associated with IBM Cognos Dynamic Cubes are
organized into the following functional groups: interfaces, application tier
components, and Content Manager components.

Client-based interfaces
The following client-based user interface is available for use with IBM Cognos
Dynamic Cubes.

IBM Dynamic Query Analyzer

IBM Cognos Dynamic Query Analyzer is an Eclipse-based client user interface that
provides graphical representations for the query logs produced by dynamic query
mode queries. In addition, Cognos Dynamic Query Analyzer includes the Dynamic
Cubes Aggregate Advisor, a tool that analyzes dynamic cubes and recommends
cube aggregation, based on available cube definitions and optional query load, to
improve query performance.

Aggregate Advisor can also analyze previously run Business Intelligence reports
and suggest aggregates that correspond directly to these reports. For more
information, see the IBM Cognos Dynamic Query Analyzer User Guide.

Application tier components
The IBM Cognos Business Intelligence applications tier contains one or more IBM
Cognos BI servers. An IBM Cognos BI server runs requests, such as reports,
analyses, and queries, that are forwarded by a gateway. An IBM Cognos BI server
also renders the IBM Cognos Connection and studio interfaces. Report authors use
the dynamic cubes as data sources in reporting applications.

Publishing, managing, and viewing content - IBM Cognos
Connection

IBM Cognos Connection is a web portal provided with IBM Cognos Business
Intelligence, providing a single access point to the corporate data available for its
products. It provides a single point of entry for querying, analyzing, and
organizing data, and for creating reports, scorecards, and events. Users can run all
their web-based IBM Cognos BI applications through IBM Cognos Connection.
Other business intelligence applications, and web addresses to other applications,
can be integrated with IBM Cognos Connection.

Central administration - IBM Cognos Administration

IBM Cognos Administration is a central management interface that contains the
administrative tasks for IBM Cognos BI. It provides easy access to the overall
management of the IBM Cognos environment and is accessible through IBM
Cognos Connection.

Viewing and interacting with published content - Cognos Viewer

Cognos Viewer is a portlet in which you can view and interact with any type of
published IBM Cognos content. It is accessible through IBM Cognos Connection
and any existing enterprise portal.
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Professional reporting - Report Studio

Using Report Studio, report authors create, edit, and distribute a wide range of
professional reports. They can also define corporate-standard report templates for
use in Query Studio, and edit and modify reports created in Query Studio or
Analysis Studio.

Ad hoc querying and self-service reporting - Query Studio

Using Query Studio, users with little or no training can quickly design, create and
save reports to meet reporting needs not covered by the standard, professional
reports created in Report Studio.

Managing Application Data - Content Manager
Content Manager is the IBM Cognos Business Intelligence service that manages the
storage of customer application data, including security, configuration data,
models, metrics, report specifications, and report output. Content Manager is
needed to publish packages, retrieve or store report specifications, manage
scheduling information, and manage the Cognos namespace.

Content Manager stores information in a content store database.

Modeling component
Modeling components model data within data sources to structure and present
data in a way that is meaningful to users.

Designing and preparing dynamic cubes - IBM Cognos Cube
Designer

IBM Cognos Cube Designer is the modeling tool used to design dynamic,
aggregate, and virtual cubes. Relational metadata is imported to use as the basis
for dynamic cube design. Individual dynamic cubes are deployed as OLAP data
sources to Content Manager in IBM Cognos Business Intelligence.

To work with a deployed cube in the IBM Cognos studios, the modeler must also
publish the cube, configure the deployed cube for use as a data source by the
Query Service, and start the cube.

Other components
In addition to the tools that are provided, IBM Cognos Dynamic Cubes requires
the following components that are created by using other resources.

Content store

The content store is a relational database that contains data that your IBM Cognos
BI product needs to operate, such as report specifications, published models, and
the packages that contain them; connection information for data sources;
information about the external namespace, and the Cognos namespace itself; and
information about scheduling and bursting reports.

Your IBM Cognos BI product includes an embedded database, Cognos Content
Database, that you can use to get your product running quickly in a test or
proof-of-concept system. When you are ready to set up a production environment
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with your IBM Cognos BI product, set up the content store to use a supported
database that can be secured and tuned for performance and stability. The
administration portal provides features that you can use to back up and archive
the data from Cognos Content Database before moving to the new content store
database in your production environment. For more information, see the topic
about deploying the entire content store in the IBM Cognos Business Intelligence
Administration and Security Guide.

Design models and log files are not stored in the content store.

The IBM Cognos service that uses the content store is named Content Manager.

Data sources

Data sources, also known as query databases, are relational databases, dimensional
or OLAP cubes, files, or other physical data stores that can be accessed through
IBM Cognos BI. Application Tier Components use data source connections to
access data sources.
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Chapter 2. Preparing to install IBM Cognos Dynamic Cubes

Before you install IBM Cognos Dynamic Cubes, some preinstallation tasks are
required to set up your environment.

After you confirm your environment, initially complete only the required
configuration tasks so that your installation successfully runs in your environment.

The simplest and quickest way to get your IBM Cognos product to run in your
environment is to ensure that a basic installation works before you customize the
configuration. For more information, see the IBM Business Intelligence Pattern with
BLU Acceleration Installation and Administration Guide.

Use the following checklist to guide you through the setup process:
v “Review the Release Notes Before You Install.”
v “Review supported environments.”
v “Verify system requirements for IBM Cognos Dynamic Cubes” on page 6.

After you complete these tasks, you can continue with Chapter 3, “Installing and
configuring IBM Cognos Cube Designer,” on page 9 and Chapter 5, “Installing and
configuring Dynamic Query Analyzer,” on page 13.

Review the Release Notes Before You Install
Before you install your IBM Cognos product, it is important to be aware of all
issues that may affect your installation strategy.

There may be late-breaking issues that were not known when this installation
guide was created.

Review the Release Notes before you install your product. The Release Notes
contains late-breaking information about known issues, and documentation
updates and deprecation notices. The Release Notes are available from the first
page of the installation wizard. Release Notes updates are also available from the
IBM Business Intelligence Pattern with BLU Acceleration 1.0.0 Information Center
(http://pic.dhe.ibm.com/infocenter/cbiima/v1r0m0/index.jsp).

Review supported environments
To ensure that your product works properly, apply all minimum required
operating system patches, and use only the supported versions of third-party
software.

To review an up-to-date list of environments that are supported by IBM Cognos
Business Intelligence products, including information on operating systems,
patches, browsers, web servers, directory servers, database servers, and application
servers, see the supported software environments (http://www-01.ibm.com/
support/docview.wss?uid=swg27039392).

Unless otherwise indicated, IBM Cognos products are compatible with later
versions of patches and service packs from the versions stated.

© Copyright IBM Corp. 2013 5
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Cognos products and virtualization environments

The IBM virtualization policy (www.ibm.com/software/support/
virtualization_policy.html) describes IBM support for virtualization environments.

For more information, search supported server virtualization environments by
product (http://pic.dhe.ibm.com/infocenter/prodguid/v1r0/clarity/
vesForProduct.html).

Verify system requirements for IBM Cognos Dynamic Cubes
Use the following tables to check the minimum hardware and software
requirements to install and run IBM Cognos Dynamic Cubes. You might require
additional resources, such as disk space.

Hardware requirements

The following table lists the hardware requirements and specifications for a single
computer installation.

Table 1. Hardware requirements for a single computer installation

Requirement Specification

RAM Minimum: 4 to 8 GB per processor

Disk space A minimum of 2.5 GB of free space is
required to install the software, and 1GB of
free space on the drive that contains the
temporary directory used by IBM Cognos
components.

Software requirements

The following table lists the software requirements and specifications for a single
computer installation.

Table 2. Software requirements for a single computer installation

Requirement Specification

Operating system Windows

Java Runtime Environment (JRE) Libraries On Windows a JRE is provided with the
installation.

Database IBM DB2

JDBC driver libraries IBM DB2 Universal Database™ for Linux,
UNIX, and Windows,

JDBC driver files

The following table lists the JDBC (Java Database Connectivity) driver files for
common database software.
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Table 3. JDBC driver files for common database software

Database software Driver
Native system
libraries

IBM DB2 Universal Database for
Linux, UNIX, and Windows

IBM DB2 Universal (Type 4) None
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Chapter 3. Installing and configuring IBM Cognos Cube
Designer

Dynamic cubes are databases optimized to provide high speed query performance
over large data sets of metadata for business intelligence reporting and analysis.
The dynamic cubes provide high speed query performance by implementing the
following features: using targeted caching (reducing how often queries are issued
to the database); aggregate tables (providing levels of aggregation at a higher level
than a basic fact table); and multi-pass SQL (improving the performance of
retrieving data from the database when the cache is not sufficient).

To run the IBM Cognos Dynamic Cubes software, the Business Intelligence
Application Server, and IBM Dynamic Query Analyzer must be at version 10.2.1.1
and installed to the same location as other Business Intelligence Application Tier
components.

Installation checklist for using the IBM Cognos Dynamic Cubes
software

IBM Cognos Dynamic Cubes are used to model dimensional metadata and to
create dynamic cubes to use as data sources in the Content Manager. The software
includes IBM Cognos Cube Designer for designing dynamic, aggregate, and virtual
cubes.

To install the IBM Cognos Dynamic Cubes software, perform the following tasks:
v Upgrade or install version 10.2.1.1 of the Business Intelligence Server software

on a Microsoft Windows, UNIX, or Linux operating system.
v Install IBM Cognos Cube Designer.
v Upgrade or install version 10.2.1.1 of IBM Cognos Dynamic Query Analyzer

where the IBM Cognos Business Intelligence Application Tier components are
currently installed.

v Test the IBM Cognos Cube Designer installation.

Installing IBM Cognos Cube Designer

Procedure
1. Start the installation program.

Go to the location where the installation files were downloaded and extracted
from the endpoint, and then double-click the issetup.exe file.

2. Select the language to use for the installation.
The language that you select determines the language of the user interface. All
supported languages are installed. You can change the user interface to any of
the installed languages after installation.

3. On the Installation Location panel, select the location for installation. Install
Cube Designer to its own location, separate from other client installations.

4. Accept the defaults on the Component Selection page.
5. Follow the directions in the installation wizard to copy the required files to

your computer.
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If you are installing in a directory that contains other IBM Cognos Business
Intelligence components, you are prompted to create backup copies of the files
that will be replaced.

6. In the Finish page of the installation wizard, complete the following steps:
a. If you want to see the log files, click View for the appropriate log file.
b. If you want to see late-breaking information about the product, select the

check box for IBM Cognos Release Notes
c. Click Finish.

Testing the installation of IBM Cognos Cube Designer
You can test the installation of the IBM Cognos Cube Designer by verifying that
the shortcut appears on the Start menu.

Procedure

To test the installation from the Start menu, click Programs > IBM Cognos 10 >
IBM Cognos Cube Designer.

Results

You can test Dynamic Cubes with your Business Intelligence application server by
modeling a simple cube (one dimension, one hierarchy, and one measure),
publishing it to a data source, and deploying it to a server. For more information,
see the IBM Cognos Dynamic Cubes User Guide.
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Chapter 4. Uninstalling IBM Cognos Cube Designer

Use the Uninstall wizard to remove the IBM Cognos Cube Designer software.

About this task

It is not necessary to back up the configuration and data files on a Microsoft
Windows operating system. These files are preserved during the uninstallation.

Procedure
1. Stop the IBM Cognos services.

Remember: It is important to also stop applications that are related to the IBM
Cognos service, such as IBM Cognos Connection.

2. From the Start menu, click Programs, IBM Cognos 10, Uninstall IBM Cognos,
Uninstall IBM Cognos.

Tip: IBM Cognos is the default name of the Program Folder that is created
during the installation. If you chose another name, go to that folder to find the
program.

3. In the Uninstall wizard, select the language of the installation.
4. Select the IBM Cognos Cube Designer check box, and click Next.
5. Continue following the prompts to complete the uninstallation. The

cognos_uninst_log.htm file records the activities that the Uninstall wizard
performs while uninstalling files.

Tip: To find the log file, look in the Temp directory.
6. Delete all temporary Internet files.

Results

Uninstalling does not remove any files that changed since the installation, such as
configuration and user data files. Your installation location remains on your
computer, and you retain these files until you delete them manually.
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Chapter 5. Installing and configuring Dynamic Query Analyzer

Install Dynamic Query Analyzer from the installation wizard. After you install the
product, use IBM Cognos Configuration to configure the product.

Supported environments
To ensure that your product works properly, apply all of the required operating
system patches, and use only the supported versions of third-party software.

To review an up-to-date list of environments that are supported by IBM Cognos
Business Intelligence products, including information on operating systems,
patches, browsers, web servers, directory servers, database servers, and application
servers, see the supported software environments (http://www-01.ibm.com/
support/docview.wss?uid=swg27039392).

Unless otherwise indicated, IBM Cognos products are compatible with later
versions of patches or service packs from the versions stated.

Cognos products and virtualization environments

The IBM virtualization policy (www.ibm.com/software/support/
virtualization_policy.html) describes IBM support for virtualization environments.

For more information, search supported server virtualization environments by
product (pic.dhe.ibm.com/infocenter/prodguid/v1r0/clarity/vesForProduct.html).

Install Dynamic Query Analyzer
Use the following steps to install Dynamic Query Analyzer.

Procedure
1. Go to the location where the installation files were downloaded and extracted

from the endpoint, and then run the issetup.exe file as an administrator.
2. Follow the directions in the installation wizard.

Install Dynamic Query Analyzer to its own location, separate from other client
installations.

Configure Dynamic Query Analyzer
Use IBM Cognos Configuration to configure Dynamic Query Analyzer.

Start IBM Cognos Configuration

Procedure

From the Start menu, click Programs > IBM Cognos 10 > IBM Cognos
Configuration.
If you are using a Windows Vista, Windows 7, or Windows 2008 computer, and
you have installed the product to the Program Files (x86) directory, start IBM
Cognos Configuration as an Administrator.
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Connect to IBM Cognos BI server
To configure Dynamic Query Analyzer, you must specify the location of the IBM
Cognos Business Intelligence gateway and a dispatcher for the server that contains
the reports that you want to analyze.

Procedure
1. In IBM Cognos Configuration, in the Explorer window, click Environment.
2. Enter the Gateway URI and Dispatcher URI for external applications values

for the IBM Cognos BI server.

Gateway URI
The gateway URI is a combination of the Application URI endpoint
(from CognosBIAS ), with the port and /servlet/dispatch/ext.

For example http://MyBIINAApp:80/p2pd/servlet/dispatch/ext

Dispatcher URI for external applications
The dispatcher URI for external applications is a combination of the
address of the dynamic cubes dispatcher, with the port and
/p2pd/servlet/dispatch.

For example, http://MyBIINAApp:9300/p2pd/servlet/dispatch
3. Click File > Save.
4. Close IBM Cognos Configuration.

Start Dynamic Query Analyzer
Before you start Dynamic Query Analyzer ensure that you save your configuration
settings, and that the IBM Cognos server is running.

Procedure
1. On Microsoft Windows operating systems, from the Start menu, click Programs

> IBM Cognos 10 > IBM Cognos Dynamic Query Analyzer.
2. Test the configuration of Dynamic Query Analyzer.

a. In Dynamic Query Analyzer, click Windows > Show View.
b. In the Show View dialog box, click Navigation > Content Store, and click

OK.
If the configuration is correct, in the Content Store pane, the IBM Cognos
content from the specified server displays.
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Appendix A. Accessibility features

Accessibility features help users who have a physical disability, such as restricted
mobility or limited vision, to use information technology products.

See the IBM Accessibility Center (http://www.ibm.com/able) for more information
about the commitment that IBM has to accessibility.

Keyboard Shortcuts for the Installation Wizard
Keyboard shortcuts, or shortcut keys, provide you with an easier and often faster
method of navigating and using software.

The Installation Wizard uses standard Microsoft Windows operating system
navigation keys in addition to application-specific keys.

Note: The following keyboard shortcuts are based on US standard keyboards.

The following table lists the keyboard shortcuts that you can use to perform some
of the main tasks in the Installation Wizard on the Microsoft Windows operating
system.

Table 4. List of keyboard shortcuts on a Microsoft Windows operating system

To do this Press

Move to the next field on a page Tab

Return to the previous field on a page Shift+Tab

Close the installation wizard Alt+F4

Move to the next configuration step Alt+N

Return to the previous configuration step Alt+B

Move to the next selection in a list Down arrow

Move to the previous selection in a list Up arrow

The following table lists the keyboard shortcuts you can use to perform some of
the main tasks in the License Agreement page of the installation wizard.

Table 5. List of keyboard shortcuts on the License Agreement page

To do this Press

Accept the license agreement Alt+A

Decline the license agreement Alt+D

Quit the installation wizard Alt+x

The following table lists the keyboard shortcuts you can use to perform some of
the main tasks in IBM Cognos Configuration on a Microsoft Windows operating
system.

© Copyright IBM Corp. 2013 15
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Table 6. List of keyboard shortcuts for IBM Cognos Configuration on a Microsoft Windows
operating system

To do this Press

Save the current configuration Crtl+S

Close IBM Cognos Configuration Alt+F4

Rename the selected item F2

Display the File menu Alt+F

Display the Edit menu Alt+E

Display the View menu Alt+V

Display the Actions menu Alt+A

Display the Help menu Alt+H
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Appendix B. Setting up an unattended installation

Set up an unattended installation and configuration when you want to install an
identical configuration across several computers on your network or to automate
the installation process by specifying options and settings for users.

There are two ways to set up an unattended installation. Both methods use a
transfer specification file (.ats) to copy IBM Cognos Dynamic Cubes components to
your computer without you being prompted for information.

One method allows you to run the Installation Wizard on your computer. The
selections that you make are recorded in a transfer specification file (.ats). You can
use the generated .ats file to perform an unattended installation across other
computers on your network. Alternatively, you can use the default response.ats file
to automate the installation. The installer uses the values in the response file rather
than requiring you to interact with it.

Before you set up an unattended installation and configuration, ensure that all the
system requirements and prerequisites are met and that all other software that you
need is installed and configured.

To set up an unattended installation and configuration:
v Configure a transfer specification file (.ats) to specify installation options
v Run the installation tool in silent mode

Setting up the installation using a file generated from the Installation
Wizard

You can install IBM Cognos Dynamic Cubes components by using a transfer
specification file (.ats) generated from a previous installation.

About this task

By default, each time you install IBM Cognos Dynamic Cubes components using
the Installation Wizard, the options that you select are recorded in a transfer
specification file. Therefore, if you already installed IBM Cognos Dynamic Cubes
components on a deployment computer, you can use the generated transfer
specification file as a template for unattended installations on different computers.
You can use the file as a template by starting the installer from the command line
and passing the response file in as an argument.

You can determine whether the unattended installation was successful by checking
the return status. A value of zero (0) indicates success, and all other values indicate
that an error occurred.

Procedure
1. Use the Installation Wizard to install IBM Cognos Dynamic Cubes components

on one computer.
2. Go to c10_location/instlog directory.
3. Locate the transfer specification file (.ats) that was generated.

The file name format is ts-DCUBEMODEL-version-yyyymmdd_hhmm.ats.
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4. Copy the transfer specification file to the computer where you plan to install
IBM Cognos Dynamic Cubes.

5. In a text editor, open the transfer specification file (.ats) that you copied.
6. In the IBM License Agreement section, change the I Agree property to y.

This action means that you are accepting the license agreement. To read the
terms of the license agreement, see the LA_language_code and notices files on
the computer from which you copied the response.ats file, in the
c10_location\license\product directory.

7. Save the transfer specification file to a local directory and in the same folder
(the directory where you extracted the contents of the installer endpoint file)
that contains the installer executable file issetup.exe.

8. Install IBM Cognos Dynamic Cubes.
Open a Command Prompt window, change to the win32 directory where you
extracted the contents of the installer endpoint file, where the installer
issetup.exe file is located, and type the following command:
issetup -s location/filename.ats

Where location is the directory where you saved the transfer specification file.

Results

If a return status other than zero (0) is returned, check the log files for error
messages. Errors are recorded in the c10_location\instlog directory in a summary
error log file. The file name format is tl-DCUBEPMODEL-versionyyyymmdd-
hhmm_summary-error.txt.

If errors occur before sufficient initialization occurs, log messages are sent to
tl-DCUBEPMODEL-version-yyyymmdd-hhmm.txt log file in the Temp directory.

Setting up the installation using the default transfer specification file
You can install IBM Cognos Dynamic Cubes components by using the default
transfer specification file (response.ats).

About this task

If you do not use the Installation Wizard to install components, you can use the
default transfer specification file named response.ats that is available on the
product disc. Use the response.ats file to copy IBM Cognos Dynamic Cubes
components to several computers without being prompted for information.

You must modify the response.ats file for your environment before you can use it
for an unattended installation.

You can determine whether the unattended installation was successful by checking
the return status. A value of zero (0) indicates success, and all other values indicate
that an error occurred.

Procedure
1. On the target computer, download and extract the component installation files

from the endpoint.
2. Go to the directory for your operating system and in a text editor, open the

response.ats file.
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Each section in the response.ats file corresponds to a window in the
Installation Wizard.

3. In the License Agreement section, change the I Agree= property to y.
This action means that you are accepting the license agreement. To read the
terms of the license agreement, see the LA_language_code and notices files in
the root installation directory for the operating system on the product disc.

4. In the APPDIR= location, type the installation location of the program files for
the IBM Cognos Dynamic Cubes component.

5. For a Windows installation, for the APPFOLDER= property, type the name of
the Start menu folder that contains your program shortcuts.

Tip: To ensure that the shortcut folder is visible to all users, for the
ALLUSERS_FLAG= property, type 1.

6. In the section named [Component List], next to each component:
v To install the component, type 1.
v To not install the component, type 0.

For example, if you require only IBM Cognos Dynamic Cubes, set the value
for DCUBEMODEL_APP to 1.

7. Ensure that there are no spaces on either side of the equal sign (=) for all
changes set in the transfer specification file.

8. Save the transfer specification file to a local directory.
9. Go to the directory where you saved the transfer specification file.

10. Install IBM Cognos Dynamic Cubes.
Open a Command Prompt window, change to the win32 directory where you
extracted the contents of the installer endpoint file, where the installer
issetup.exe file is located, and type the following command:
issetup -s location/response.ats

Where location is the directory where you saved the transfer specification file.

Results

If a return status other than zero (0) is returned, check the log files for error
messages. Errors are recorded in the c10_location\instlog directory in a summary
error log file. The file name format is tl-DCUBEMODEL-versionyyyymmdd-
hhmm_summary-error.txt.

If errors occur before sufficient initialization occurs, log messages are sent to the
tl-DCUBEMODEL-version-yyyymmdd-hhmm.txt log file in the Temp directory.
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Notices

This information was developed for products and services offered worldwide.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service. This document may
describe products, services, or features that are not included in the Program or
license entitlement that you have purchased.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Software Group
Attention: Licensing
3755 Riverside Dr
Ottawa, ON K1V 1B7
Canada

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.
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Trademarks

IBM, the IBM logo and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “ Copyright and
trademark information ” at www.ibm.com/legal/copytrade.shtml.

The following terms are trademarks or registered trademarks of other companies:
v Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered

trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

v Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

v Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

v UNIX is a registered trademark of The Open Group in the United States and
other countries.

v Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.
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